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Welcome to the latest edition of my monthly Final Cut Studio newsletter. This is the September, 2006, 
edition.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 125 
tutorials to help you get the most out of Final Cut!

Well, school's started and soon Fall will be upon us. Life is starting to pick up from the lethargy of summer. 
Though, I'm not sure about this lethargy business -- there's nothing lethargic about editing deadlines.

Enough philosophy -- let's get started.

Newsletter Contents

●     Hot News: A New Version of Final Cut Announced at IBC
●     Power-Up Seminar Tour Starts
●     Technique: Adjust Audio Filters in Real-time During Playback
●     Technique: Slipping Audio Keyframes
●     Technique: Visibility Lights Affect Up/down Arrow Keys
●     Tip from the classroom
●     New Training Products in Our Store
●     Technique: Finding Clips
●     Technique: Coloring a Filter
●     Definitions: Insert vs Overwrite editing
●     Setting up a Tascam FS-1082 Audio Mixer 
●     Comments on Video Cataloging Software
●     Comments on Burning DVDs 
●     This month in Edit Well
●     A Sad Lesson from the Trenches

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/


●     Working with Images - Redux
●     Reader Mail 

❍     Problems with Soundtrack Audio
❍     An Editing Competition
❍     Working with EPS images
❍     Transforming XML files
❍     Problems Compressing with Compressor
❍     DV Creators' QuickTime Note Taker
❍     Doing an Audio-Only Edit of a Sequence
❍     Audio Nesting Problems
❍     Video Conversion Tip
❍     Ripping Video from DVDs
❍     Archive Follow-up
❍     Shooting with a Sony Z1 HDV Camera
❍     Getting a Panasonic AJ-D750 Deck to Work with Final Cut
❍     De-interlacing
❍     Choosing the Right Font
❍     Converting VHS into Something Useful
❍     Dealing with a Bad Drive
❍     Running Avid Codecs on an Intel Mac
❍     Working with Slugs in PAL

●     Things I'd Like to Know
●     Wrap-up

Hot News! A New Version of Final Cut Announced at IBC

Apple announced a new version of Final Cut Pro at IBC on September 8, 2006. I contacted Paul Saccone, 
Senior Manager, Pro Apps Marketing, and he sent me the following email:

At IBC this week we demonstrated Final Cut Pro 5.1.2 -- a maintenance release that 
provides compatibility with a variety of cameras and devices as well as a significant number 
of stability and reliability improvements that customers have requested. Final Cut Pro 5.1.2 
will be available via Software Update for registered users of Final Cut Pro 5.1 within the next 
30 days.

Final Cut Pro 5.1.2 includes RT profiles for the latest Apple Mac Pro and iMac hardware. 

This release provides the following format compatibility:

●     SONY XDCAM HD: Adding 1080 25P and support for native 18- and 35 Mbit VBR 
MPEG HD. Support now includes 

❍     1080i 50/60, 1080p 24/25/30
❍     Native 25 Mbit CBR, 18- and 35 Mbit VBR MPEG HD for HD
❍     Native IMX 30 for SD

●     PANASONIC: 720 25P from P2 devices. Support now includes
- 1080i 50/60, 720p 24/24N/25/25N/30 form P2 cards

●     PANASONIC: 1080pA 24 (Advanced Pulldown) now supported via FireWire from AJ-



HD1200A
●     PANASONIC: more reliable P2 import dialog with ability browser, mark, and ingest in 

the background.
●     CANON: 1080p 24/25 HDV
●     JVC: 720p 24/25 HDV

Other stability and reliability improvements include:

●     Scope and Monitors. Improved accuracy; scopes can now sample every video line. 
Scopes will also update in real-time during video playback.

●     BWF compatibility
●     Improved edit-to-tape accuracy for D5
●     Compatibility with insert editing to audio channels 5-12 on decks
●     Now compatible with some FxPlug filters
●     Gamma control for imported graphics
●     Media Manager is now more reliable
●     EDL and Cinema Tools lists
●     XML for developers
●     Metadata preservation in QT files

Larry: I also asked Paul about support for Sony's new HDCAM video format. Paul replied: 

We shipped XDCAM HD support shortly after NAB with Final Cut Pro 5.1.1. All that's 
required is the 5.1.1 update and Sony's XDCAM Transfer software (free). 

There's a white paper that articulates the XDCAM HD workflow available at:

http://www.apple.com/finalcutstudio/resources

(check out our other white-papers too!!):

Larry: For me, while the additional HD formats are good news, especially the PAL formats, the exciting 
news are chagnes to scopes and media manager. Finally, video scopes now sample every line, rather than 
only 16, and they display in real-time! AND, Apple has started to make Media Manager more reliable. This 
is GREAT!

I'm looking forward to getting the new update and reporting on it to you. Plus, I'll be demoing the new 
version in my upcoming seminars as soon as it's available!

[ Go to top ]

Power-Up Seminar Tour Starts

My Power-Up with Final Cut Studio Seminar starts September 21 and visits 13 cities across North America, 
including:

●     Sacramento - Sept. 21 - 22
●     Los Angeles - Sept. 29 - 30

http://www.apple.com/finalcutstudio/resources


●     Chicago - Oct. 6 - 7
●     Portland, OR - Oct. 11 - 12 

We are only doing two seminars in each city and I am really excited about the content:

●     Optimize Your Editing With Final Cut
●     The High-End of Final Cut Studio

If you are new to Final Cut, or if your skills are self-taught, you will be blown away by what you learn at the 
Optimize seminar -- faster ways to edit, better ways to optimize your system, improved trimming -- 
including some little known real-time techniques -- plus lots of time to get your hardest technical questions 
answered.

If you earn your living with your Final Cut skills, you need to attend our High-end seminar. We totally 
updated the content and beefed up coverage of High-Def, HDV, HDMI, capture cards, Soundtrack Pro 
filters and mixing, and a detailed look at how to improve your video compression for DVD. We'll be 
traveling with a fully-loaded MacPro and some fascinating hardware -- so we won't just talk about it, we can 
show it. And, as usual, we've allowed extra time to answer your toughest technical questions.

Plus, we will be demoing the latest version of Final Cut as soon as it's released by Apple, and some brand-
new capture cards from Blackmagic Design. 

To learn more, or to reigster, visit www.larryjordan.biz/seminars -- as well, everyone attending will receive 
hundreds of dollars in free goodies, including a free copy of my Hands-On Training for Final Cut Pro 5 
book, free passes to Lynda.com, Final Cut filters from Graeme Nattress, Loren Miller's world-famous 
keyguides, demo copies of SyncVue and more -- the exact goodies depend upon which seminar you 
attend and all are designed to help you make the most of your Final Cut system.

Ask your friends who've attended a past seminar, they will tell you my events can catapult you into a whole 
new level of job performance -- besides, I'd love to meet you.

I am grateful to Blackmagic Design for their sponsorship of this tour. Click here to learn more, or to register: 
www.larryjordan.biz/seminars.

[ Go to top ]

Technique: Adjust Audio Filters in Real-time During Playback

During one of my recent classes, Steve noticed a way to adjust Final Cut audio filters in real-time during 
playback. Huh! Certainly surprised me. Here's how to do it.

http://www.larryjordan.biz/seminars
http://www.blackmagic-design.com/
http://www.larryjordan.biz/seminars


1. I have an clip in my sequence to which I want to add an audio filter -- in this case, Reverberation. But, 
I'm not sure of the best setting for the filter. That's where real-time playback and adjustment comes in.

2. As an optional first step, I typed Option+Cmd+W to turn on waveforms. I didn't need to do this, but it 
was the only way I could think of to mention this keyboard shortcut.

3. Select the clip and apply Effects > Audio Filters > Final Cut Pro > Reverberation.



4. Set an In and an Out to represent the duration you want to review. If you don't set an In and/or an Out, 
Final Cut will play your entire sequence from beginning to end. Normally, I would set the In and Out at the 
beginning and end of a clip -- but, to make my screen shot easier to read, I put it in the middle of the clip.

5. Double-click the clip to load it into the Viewer and click the Filters tab. This screen illustrates the 
default setting of the Reverberation filter, which has way too much effect (50). 



6. This is the magic part. Go to the View menu and turn ON Loop Playback, so it's checked. Then, type 
Shift+\ (that's the backslash key, immediately above the Return key). 

Your sequence will immediately start to play from In to Out, looping over and over. Adjust the effect slider, 
in real-time, while listening to your clip, until you get the effect you want.

Very cool.

[ Go to top ]

Technique: Slipping Audio Keyframes

The following technique was contributed by Andy Mees. 

[In last month's newsletter, I] noticed Larry's comments on slipping keyframes. This was with 
respect to applying a video filter to a specific portion of video by use of the range selection 
tool ... oh clever me, I already knew about filters and range selection, but Larry's info was 
describing how one would use the slip tool in the viewer to slip the selected range, and 
therefore also the associated keyframes. Normally, my practice would be to slip video filter 
keyframes using the click and drag method within in the clip keyframe area in the timeline ... 
however, I knew that this trick only applies to video filter keyframes not to audio level 
keyframes.

Anyway, the article prompted me to have a look at slipping audio level keyframes... and sure 
enough it works, albeit without benefit of GUI feedback.

Lets assume that you have applied a series of audio level keyframes to a clip and now wish 
to slip them a little, heres how:

1.  Load the audio clip from the timeline into the viewer
2.  Select the Slip tool
3.  Then simply click and drag on any keyframe (or anywhere on the level line itself) 



within the waveform area of the viewer to slip the clip's keyframes (the cursor will 
change to the slip tool as you hover over the right area)

... release the mouse button and you'll see that the keyframes have indeed slipped 
appropriately, whereas the clip's in, out and placement, has remained unchanged. 

Unfortunately however, there's none of the feedback that we've come to expect from rest of 
the FCP interface during this process... no phantom marks showing where the keyframes 
are moving to, no counter to show how many frames left and right the keyframes are being 
moved. 

It seems to be another one of those not-quite-finished undocumented features.

[ Go to top ]

Visibility Lights Affect Up/Down Arrow Keys

Lisa, one of my students, discovered a visibility light feature that I didn't know - they have an effect on how 
the up/down arrow keys behave.

First, the visibility lights are the glowing green buttons on the extreme left side of your timeline. When the 
light is green, the track is "visible." That means you can hear the audio or see the video contained on that 
track.



If the light for a track is dark, it means that the audio is inaudible, or the video is invisible. This has a variety 
of uses in effects and exporting, but for now, we want to look at something different. You change the 
setting of a visibility light by clicking on it. 

Load a sequence with multiple edits. Pressing the up/down arrow keys jumps to the next/previous edit 
point. Now, turn off the visibility lights on some of the tracks. Pressing the up/down arrow keys skips all edit 
points on tracks whose visibility light is dark.

[ Go to top ]

Tip from the Classroom



Adam discovered that you can keyframe the Color Corrector 3-way filter -- provided you set an initial 
keyframe. The easiest way to do this is click the keyframe diamond at the top of the filter. After that, 
moving the playhead and adjusting a parameter automatically sets a new keyframe.

[ Go to top ]

New Training Products in our Store

In partnership with Lynda.com, we released three new DVD training titles last month -- all of which are now 
available in our store:

●     Optimizing and Troubleshooting your Final Cut System
●     Essential Training for LiveType 2
●     Essential Training for Motion 2

If you are new to Final Cut, I strongly urge you to buy Optimizing and Troubleshooting your Final Cut 
System. It will help you solve the vast majority of common Final Cut problems, including dropped frames 
and trashing preferences. At only $49, it should be part of your regular editing kit.

Essential Training for LiveType 2 is a look at the power of LiveType -- including a very nice way to create 
scrolling credits that pause at the end. And a whole lot more, including creating LiveType templates, 
modifying an existing effect parameter and working with a randomize effect that I found flat-out amazing. At 
$49, this is a great title at a great price.

Essential Training for Motion 2 walks you thru everything you need to know to get up and running on 
Motion. Especially because the power of Motion is not in its keyframes, but in its behaviors -- real-time 
effects that require no keyframes and no programming. At $99, this is a great way to get up to speed on a 
whole different way to create effects. 

To learn more, or order your own copies, visit our store: www.larryjordan.biz/store/index.html.

[ Go to top ]

Technique: Finding Clips

Dilesh Korya, a long-time reader and contributor, has written a very nice article on using the Find Menu in 
the Browser to find clips. This is targeted toward documentary editors, but the information can be used by 
anyone.

Click here to download the 3-page PDF: www.larryjordan.biz/articles/dk_find.pdf 

[ Go to top ]
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Technique: Coloring a Filter

France Chee, from the Trinity College Institute of Neuroscience (and how many times do I get to say 
THAT in this newsletter??), in Dublin, Ireland, writes:

I would like to apply a "fisheye filter to still image I have imported from Photoshop into FCP 
(I'm using FCP4.5 by the way).

OK, so I do this and have the fish eye effect move across my image in the pattern that I want 
but what I would like is the filter to effect to be in Red, i.e. the fish eye and the rest of the 
image where the filter is not distorting be the original color. Or something similar to this.

Essentially the effect I'm after is to have a distorting image with only the distorted region in 
say blood red and this gradually spreads with the movement of the fisheye.

Is this possible to do?

Larry replies: Yes, but it involves creating a traveling matte where you colorize a copy of the clip. Here's an 
article that describes the process or creating a traveling matte -- use this to get a better understanding of 
what we are doing: www.larryjordan.biz/articles/lj_travel.html.

Now that you understand how to create a traveling matte, here's one way to create your effect.

http://www.larryjordan.biz/articles/lj_travel.html


1. Start by putting your original clip on V1. In this case, I'm using a shot of three balloons.



2. Go to the Generator menu (lower right corner of the Viewer) and generate a Circle shape. (You can use 
any shape, I picked a circle based on your description.) You adjust its size in the Controls tab in the 
Viewer. Edit the circle onto track V2 so that it runs the same duration as the V1 clip.

3. Duplicate the V1 clip and put it on V3. This is the clip that will have your red effect. It must start at the 
same time as the V1 clip and have the same duration. 

4. Select the V3 clip, now we need to create your red effect. 

5. In this case, I applied Effects > Video filters > Distortion > Pond ripple to the clip and adjusted the 
settings as you see here.



6. Then, to change the color to red, I applied Effects > Video Filters > Color Correction > RGB Balance 
and adjusted the settings as you see here.

7. Here's what the effect looks like so far. Now we need to constrain it so it doesn't cover the whole image.



8. Double click the Circle on http://www.larryjordan.biz/articles/lj_travel.html and scale it to the size you 
need for your effect. In this example, I scaled it to 25% of normal.

9. Select the Motion tab for the circle and apply Center keyframes to move it around the screen as 
necessary.



10. To restrict the effect just to the size and location of the circle, select Modify > Composite modes > 
Travel Matte Luma. Now, your red ripples will be exactly the size and shape of the circle and move where 
ever the circle moves. 

You can use any shape, at any size, with any effect -- however, they are all constructed the same way.

[ Go to top ]

Definitions: Insert vs. Overwrite editing

This technique was suggested by an email from Bob Hughes, who wrote:

I have just assembled all my dance performance clips on the timeline and everything so far 
is in sync. Now I need to put extra clips (part of an interview with the dance teacher) right at 
the front, is there a way of pushing all the clips back to give me the space I need without 
throwing all my clips out of sync?

Larry replies: Yup. there are two types of edits within Final Cut: an overwrite edit, which replaces whatever 
it lands on in the timeline, and an insert edit, which "inserts" itself into the timeline at the point of the 
playhead.

My recommendation is to always use an Overwrite edit as your default edit, because it will give you the 
results you expect. However, for those occasions when you need to insert a shot, without damaging any 
material that is already edited, the Insert edit is your choice.



To do an Insert edit, set your In and Out on a clip in the Viewer. Then, position the playhead in the timeline 
where you want to insert the clip. Finally, drag the clip from the Viewer to the Canvas and drop it on top of 
the yellow Insert overlay menu that appears.

Your clip is automatically inserted at the position of the playhead in the Timeline and all the clips to the 
right of the inserted clip are shifted to the right.

[ Go to top ]

Setting up a Tascam FS-1082 Audio Mixer 

Taylor Collins, from Albuquerque, New Mexico, writes:

I've been happily using a Tascam FW-1082 work surface mixer with Final Cut.... Firewire in 
and out, and a connection from the monitor output to an amplifier and speakers.... No 
problem...

But when I tried to use the same set-up with SoundTrack Pro... 80% of everything worked 
fine... I had remote control of the sliders on the work-surface, audio meters bouncing 
happily... but STONE SILENCE. I puzzled, and puzzled, and puzzled over all of the 
windows, settings, preferences, etc. within SoundTrack... reinstalled the Tascam FW-1082 
drivers, etc... but still nothing.

Finally, with the help of the Tascam tech support folks... we found the problem. In the Apple 
System Prefs menu.. under Sound... there is an Output option for the Tascam FW-1082. 
FinalCut completely ignores this setting, and works fine wherever it is set... SoundTrack 
insists on having this setting set to the FW-1082. Go figure....

Anyway... this probably won't totally rock the world of video production... but it might help 
somebody, somewhere... 

Larry replies: Taylor, thanks for writing. Everything helps -- because none of us know everything about this 
software. 



  
  
  
  
  
  
  
  
  
  

A while back, Tony Liuzzi wrote a brief white paper on how to hook up the FS-1082 mixer. You can 
download the PDF file here: www.larryjordan.biz/goodies/fcp5setupwithfw1082.pdf.

[ Go to top ]

Comments on Video Cataloging Software

Last month, I asked people to share their thoughts on good video cataloging software. Here's what I 
learned:

Andy Mees writes: 

If your clips are already captured, then Digital Heaven's "Movie Logger" is a great app. If 
you're logging tape-based media and want to also build a database of these clips, then I love 
CatDV's ability to log and capture direct to low-res preview quality ... there are plenty of 
prettier apps for logging DV out there (for example Foottrack and iDive) but neither of those 
will let you directly capture that low-res copy without first capturing at full-res.

Larry replies: Here are the links to the software Andy mentioned:

●     Movie Logger: http://www.digital-heaven.co.uk/movielogger/
●     catDV: http://www.squarebox.co.uk/index.html
●     Foottrack: http://foottrack.com/
●     iDive: http://www.aquafadas.com/idive-digital-video/index.php

Jonathan Kirsch, at Synergy Fine Wines, writes:

First, thanks for all your hard work in sending out the monthly newsletters...I'm learning a 
heck of a lot. Second, you were asking for what software we like to use to log video. Well, 
the guys at dvcreators.net have made a nice little QuickTime movie logger. Here's the link:

http://www.dvcreators.net/qt-movie-notetaker/

It's still in the beta stage, and they're trying to get one out that reads SMPTE, but this is 
pretty handy as it is!

Chad Purvlance writes:

I recommend FootTrack - www.foottrack.com 

I have been using FootTrack for just over a year now and to date I have cataloged 124 
tapes, Most are DV and it nicely pulls in the clips with timecode but it also does a nice job of 
logging the Analog video (both imported from PC in AVI and Imported via iMovie) It also has 
nice XML lists for Final cut.

The feature I like most (aside from search ability) is the h.264 compressed clips. My Archive 

http://www.larryjordan.biz/goodies/fcp5setupwithfw1082.pdf
http://www.digital-heaven.co.uk/movielogger/
http://www.squarebox.co.uk/index.html
http://foottrack.com/
http://www.aquafadas.com/idive-digital-video/index.php
http://www.dvcreators.net/qt-movie-notetaker/
http://www.foottrack.com/


of native DV is approx. 1.9 Terabyte (the analog tapes were 2-hr) but the 720x480 HW h.264 
clips take about 200g, I am now going through and deleting the DV clips I will never use and 
some that I would only re-digitize if I had too.

Cheap, does a great job, great support. 

[ Go to top ]

Comments on Burning DVDs

During recent months we've been having an on-going discussion on how to burn DVDs that will last longer 
than a nanosecond and be reasonably compatible across multiple devices. I've discovered things are still 
pretty well screwed up. Here are some reader comments:

Andy Mees writes:

If both your media and your burner support a higher burn speed then you'll get a faster 
burn ... but the encoding won't be any faster!

Uli Plank, from Braunschweig, Germany, writes:

From the findings of a well respected German computer magazine, which has done 
hundreds of tests with expensive Swedish equipment, things are like this:

1.  Its a common misconception that burning todays DVDs at single speed is any safer. With DVDs 
rated at 8x or even 16x, burning at 1x is resulting in less readability.

2.  It's also not advisable to use the highest speeds, at least not 16x, they got the best results when 
burning at 4x or 8x.

3.  There was a minor tendency of DVDs rated for 8x burning better at 4x and those rated for 16x 
better at 8x, but that difference was marginal.

Matt Davis settled deeper into his chair and wrote:

(sighs and pulls nice scotch from cupboard, a few fingers each...)

In my experience, the built-in Mac burner seems to do something 'else' that makes it flunk on 
fussy PCs.

Certainly, burning at the higher speeds leads to more failures but the end client doesn't see 
this problem. Only we do.

For compatibility with low-end DVD players (like the newer breeds of portable DVD players), 
it's mostly about bandwidth bumps (and not converting AIFF to AC3) but media 'colour' has 
reared its ugly head. Usually it's DVD+R vs DVD-R.

Bottom line, though: nightmare client with AlienWare Area 51 laptop. Anything burned in my 
PowerBook G4 was unreadable. If I burned it with conservative (but not 1x) settings using a 
FreeCom USB DVD burner, everything bloomed in the garden. Same file, same app, same 



source files. Simply burn from DSP to FreeCom instead of internal Matsushita, and 
everything's fine.

Haven't gone over 4x though...

Larry adds: To everyone that wrote, thanks for taking the time. I really appreciate it. If you have addtional 
comments, I'd like to hear them. 

[ Go to top ]

This Month in Edit Well

I am continually blown away by the glowing response to Edit Well - the rich-media newsletter for Final Cut 
Studio, published by Peachpit Press, which I have the great pleasure of editing.

A subscription is only $59.99 per year -- and well worth it.

Here's what's in this month's (September) issue:

●     More information from Paul Saccone on the latest version of Final Cut Pro
●     An audio interview with Lt. Mike Peery, who uses Final Cut for fire-fighter training
●     Brian Gary starting a two-part series on using Motion
●     Alexis Van Hurkman continuing his four-part tutorial on color correction, this time looking at how to 

adjust contrast and exposure
●     Graeme Nattress walking you step-by-step through the process of creating your own effects using 

Final Cut's FX Script
●     Kevin Monahan's tutorial on how to create pan-and-scan image effects in Final Cut
●     Steve Martin showing you how to create a movie trailer effect with LiveType
●     A short article on how to output a sequence with burned-in timecode
●     A video tutorial from me about how to improve your capture techniques
●     And more including keyboard shortcuts, tips, and another audio interview 

Edit Well is 35 pages of Final Cut tips and techniques that you just can't find anywhere else. Act quickly - 
the next issue comes out the last week of each month. Click here subscribe: www.peachpit.com/editwell.

Coming up in the October issue are articles, interviews and tutorials covering:

●     A First Look at the new scopes and media manager in FCP
●     How to seamlessly move files between the different Studio applications
●     How to use Soundtrack Pro to repair your audio
●     Fascinating color effects using masking
●     Creating an H.264 movie using Compressor
●     And lots more interviews, video tutorials and more.

I've been teaching, researching and writing about Final Cut for over four years -- there's nothing like Edit 
Well; not in print, not on the web and not in the classroom.

If getting the most out of Final Cut is important to you, take a few minutes and subscribe to Edit Well: www.

http://www.peachpit.com/editwell
http://www.peachpit.com/editwell


peachpit.com/editwell. And, if you have any problems subscribing, send me an email.

[ Go to top ]

A Sad Lesson From the Trenches 

David Black, of Maldenite Productions, shares a very sad story of missing files:

I spend a great deal of my time listening to you and it's always interesting and entertaining. 

In order to "keep my FCP documents organized" I accidentally deleted some very important 
FCP documents! I thought FCP was tracking them on my media drive. Obviously, I didn't 
realize that they were on another external hard drive in another "FCP document folder."

What started this nightmare was when I noticed other "FCP documents" folders on my other 
drive that was not used for media. They were not on the designated "media drive". I was 
thinking, I better get rid of those other FCP document folders. Big mistake when I didn't 
archive as a self contained movie or make sure I had the original video tape in my 
possession.

I watched your training on Lynda.com and clearly believed I had organized everything as 
you directed. I never realized that FCP would use other "FCP documents" if I was not 
careful. I believed my preference settings for storing media files was correct. I checked it 
when I tried to reconnect and it looked fine but something did happen and I am not sure why 
at this point. 

FCP is at times a very confusing program. Things get moved/stored without the user 
realizing it. Those files worked perfectly as long as reference clips looking at the original 
capture in the "FCP document folder", regardless where that folder was located. FCP is not 
particular about WHAT folder but WHERE is highly important!

OK, no problem, I will reconnect. No dice! I spent hours trying to find those files in other 
folders. No luck!

I spent $100 to purchase Data Rescue II to recover the files. After preparing my drives for 
recovery I was faced with the choice of which files were more important. FCP? QuickTime? I 
tried both. No Luck. If this happens again, and I hope not, the following questions might help 
me or some one else in data recovery.

Do you have suggestions for future "accidental deletions and recovery process"? (I know the 
obvious is to take care of the original tape. (Tears down my face.)

Questions:

●     Using any data recovery program, what kind of files should I look for during a 
recovery from a hard drive?

●     Which hard drive do I search first? My application hard drive or media hard drive?

http://www.peachpit.com/editwell
mailto:larry@larryjordan.biz?subject=Edit Well problems


My experience during the recovery process:

I looked through many QT files, no luck. I found one small file that pertain to our TV show. It 
had been a couple of weeks since last working on the project and the files were obviously 
written over. I used the FCP files and they wanted to reconnect. No luck FCP documents 
since other files were missing. It was a nightmare. 

We just started our small production company and this was a valuable lesson. We lost the 
original video tape or this would not have been necessary. Tighter control over the tapes are 
now in place. Lucky we did not have a paid sponsor and it was a "freebie" for our viewers. It 
has been a very disappointing experience. It was our local fishing show and has sponsorship 
potential.

Thanks again, I love your training with Lynda.com and Edit Well is fantastic! Thank you, if 
you got this far in this letter. I always feel like I am taking up your valuable time but I highly 
value your opinions and admire your wonderful gift for teaching.

Larry replies: First, my deep sympathy on the pain of losing your files. It has happened to all of us, but that 
doesn't make it any easier when you go through it yourself. 

Let me spend a few minutes explaining a few key concepts how Final Cut works with files.

Final Cut never imports, or moves, any files. This is the most important thing to keep in mind. Final Cut 
only points to where files are stored on your system. This means you can move or delete any file, and the 
only thing that happens in Final Cut is that the pointer, or reference, stored inside Final Cut points to the 
wrong place.

If you accidentally delete a file, there's nothing Final Cut can do to help you. As you guessed, you need to 
use standard data rescue programs to get your files back.

All Final Cut media files are QuickTime movies. So, when you are searching for a lost file, you only need to 
look for .mov files. Audio files are most often AIFFs. Image files can be any of a number of formats, 
however, the most popular are PSD, PNG and TIFF.

Media files are stored where ever your scratch disks point. My recommendation is that you always store 
media files on your second drive. This is principally for performance reasons. This means that if you need 
to recover accidentally erased files, you will need to look on your second drive first.

I recommend that all other files be kept in a single folder, that I call the "Project Folder." This can be 
anywhere - however, I recommend you keep it on your boot drive to make it easy to find, backup and 
archive.

I'm sorry you lost your files -- I hope this helps you prevent that problem from recurring in the future.

[ Go to top ]

Working with Images - Redux



During the last several months, I've had a very frustrating one-side email conversation with David Scott, 
over at BellSouth.

David writes these great emails about his trials and tribulations of getting still images imported into Final 
Cut. And he ends each email asking a series of interesting questions.

However, every time I write back, my email gets bounced. It is very frustrating. So, David, I am NOT 
ignoring you -- however, your email system is not allowing me to reply.

Here's his most recent question and my answer:

Larry - After much experimentation, I've found that I can eliminate the subtle "squashing" I 
mentioned by creating my file at one size, then resizing it ("constrain proportions" 
unchecked). This absolutely works if I create at 720x531x72, then resize at 720x480x72. 
The resulting image on my NTSC monitor is identical to the original in Photoshop. This, of 
course, is the "old" way and recommended by many.

However, the rub comes when trying to coax more detail during the pan-and-scan process. 
Obviously, I need to increase the pixel dimensions. But simply importing (without resizing) 
an image cropped at 1800x1350 results in the squashing.

So, my question is this: What is the "creation size" and "resize size" at larger pixel 
dimensions that won't get squashed when imported into FCP 5? If 1800x1350 is the 
"unconstrained resize" at which I need to import into FCP, then what size do I need to crop 
the original in Photoshop? I've tried a number but all get squashed when imported into FCP 
5. They must be hitting that FCP table mentioned by Martin Baker.

Since I'm not significantly enlarging my animations, keeping them at 720 x 531 x 72, then 
resizing to 720x480x72 will get me by. But there must be a set of sizes applicable to the two-
step process that will get me both accurate proportions as well as detail. DCS

Larry replies: If the dimensions of 720 x 531 x 72 work for you, then you can create a larger image size to 
support panning and scanning by doubling the image dimensions to 1440 x 1062 x 72, then resizing to 
1440 x 960 x 72 in PhotoShop.

[ Go to top ]

Reader Mail

We have even more reader mail than usual -- thanks for all your comments! So, let's get started.

Problems with Soundtrack Audio

John Thomas writes:

When sending audio to Soundtrack Pro Multitrack I notice the volume is much greater in 
STP and has clipping that is not present in FCP. This is even with all but 1 track muted. Is 
there a reason for this?



Larry replies: John, I saw the same problem, until I realized that it wasn't Soundtrack Pro's fault. 

Unlike Final Cut, where the master gain for the program is hidden in the Audio Mixer, the master gain for 
Soundtrack and Soundtrack Pro is right out in the open -- and it looks like the wishbone of a chicken (well, 
actually, the wishbone is the down-mix button, the master gain is just to the left of it) in the lower left corner 
of the project window, just under the small icon that looks like a purple spaceship.

Make sure that unassuming slider is set to 0 db and your gain should match between STP and FCP.

- - - [ Go to top ] - - -

An Editing Competition

Kubilay Uner sent me the following:

The Cinematic CD Film2Music Competition is inviting filmmakers to create short films to 
illustrate music tracks from my new album Cinematic, which was recently added to the 
playlist at KCRW.  

Prizes for this competition total US $17,000, with a $10,000 Grand Prize. Our distinguished 
panel of judges is comprised of six internationally renowned filmmakers, including writer/
director Michael Polish.  

We are also inviting filmmakers to post their entries online to win the Online Audience Award 
(US $5,000.) Registration is only $9 and the submission deadline for entries is November 1. 
A screening and reception in Hollywood in January 2007 is planned.

Detailed information is available at www.film2music.com. 

Most editors I know have a large amount of unused but beautiful footage languishing on their 
hard drives. This may be a great way to create something compelling and potentially 
lucrative with it!

Could you inform the editing community through your website, newsletter etc. of this 
opportunity? 

If you have any questions, need more information, or have other suggestions on how I can 
connect with your members, please do not hesitate to contact me.

Larry replies: Kubilay, thanks for writing. I'm passing your information on.

- - - [ Go to top ] - - -

http://www.film2music.com/


Working with EPS images

George Kennedy, in New York, writes:

Well, it is 4:00 AM East Cost time and I am trying to prep an EPS File ( My Logo) to use in 
FCP and Motion. I can't seem to get it right. When I do get it into Motion it looks like crap (i.e. 
dull). Do you have any suggestion please.

Larry replies: EPS is a vector-based format, which doesn't work in video. You need to convert it into a TIFF 
or PNG using PhotoShop and it will look great. Here's an article that illustrates what image size to use, 
depending upon your video format.

- - - [ Go to top ] - - -

Transforming XML files

Andy Mees writes:

[Last month, ] there was another question from a reader regarding the ability to transform 
Filemaker XML files into something that FCP can use ... this is essentially a straightforward 
process. One uses something called "XSL" which is a language used to transform XML 
documents from one format to another. It's most commonly used for transforming XML into 
HTML, for web pages, but would work just as well to transform a Filemaker XML to a Final 
Cut Pro XML. That said, your reader will need a XML wizard to apply these XSLT's (XSL 
Transform).

Larry replies: Andy, thanks for the follow-up. Here are two links to learn more about XSL:

●     http://www.xmlfiles.com/xsl/
●     http://www.w3.org/TR/xsl/

- - - [ Go to top ] - - -

Problems Compressing with Compressor

Liesbeth Nieuwenweg, from the Netherlands, writes:

I have a problem: I have a Quicktime movie of 4 minutes with an .aiff file as a soundtrack. I 
compressed it in Compressor with best quality settings (90 Minutes encoding setting) at a 
bitrate of 7.7 (the maximum bitrate allowed). I am using the SD Video settings NTSC.

When I try to build a dvd in DVD Studio Pro I get the message that the bit
rate is too high and the building process is aborted. When I encode it through DVD Studio 
Pro with the same settings, it does work. 

What might be the problem here?

Larry replies: Liesbeth, there are a number of problems with Compressor, depending upon which version 
you are using. I've had significant difficulties with the version of Compressor shipped with Final Cut Studio 

http://www.xmlfiles.com/xsl/
http://www.w3.org/TR/xsl/


5.0.x, which were fixed in the 5.1.x release.

However, your bit rate is too high -- I have been told by people who's opinions I respect that DVD Studio 
Pro likes bit rates closer to 6.0 than 8.0. For this reason, I recommend using an average compression rate 
of 5.5 and a maximum compression rate of 7.2.

Those settings have given me good results every time.

- - - [ Go to top ] - - -

DV Creators' QuickTime Note Taker

Frederick Church, from Auckland, writes:

Once again many thanks for a very informative and thought provoking newsletter, I have 
recently come across a most wonderful piece of software called QT Movie Note Taker from 
DV creators.net. I have used it extensively in tidying up a feature that was a little sloppily 
edited. I was given a copy of the finished feature, I loaded it up it Note Taker and went 
through and made comments and suggestions at each and every cut point, *sighs*.
I found it a very good product with advances and updates coming regularly. A very 
worthwhile addition to your editing arsenal of applications!

Keep up the excellent work and look forward to my next issue of EditWell!

Larry replies: Josh Mellicker, over at DV Creators, has a bunch of new products bubbling in their pipeline. 
To see the latest, visit: http://www.dvcreators.net.

- - - [ Go to top ] - - -

Doing an Audio-Only Edit of a Sequence

Reid Kramer, writes:

I am trying to select just a portion of the audio on A1 and drop just that piece of audio into 
another sequence. I selected my in and out on the audio and I only selected the auto-select 
button for the A1 track. I then went to the browser and command/dragged the sequence to 
the timeline. But it always wants to bring the video with it also. If I don't command drag the 
sequence into the timeline, it will let me insert the audio only, but then the name of the audio 
file is not there. The new inserted file will say the name of the sequence I pulled it from.

Do you know a way to import only the audio from one sequence into another and have the 
name of the audio file stay with it?

Larry replies: It's actually very easy to do this -- the key is not to drag your sequence to the timeline, but to 
edit it. Here are the steps:

1.  Load your sequence into the Viewer

http://www.dvcreators.net/


2.  Click once on all the small v1, v2, v3 patches on the extreme left side of the timeline so there is a 
small gap between them and the patches on the right. This disconnects the video channel in the 
Viewer from the Timeline. Tracks that have a gap in the patch panel will not edit from the Viewer.

3.  Put your playhead where you want the nested audio to be placed in the timeline.
4.  Click the red envelope button in the lower left of the canvas.

Instant audio edit. You can adjust which timeline track receives the audio by dragging the left-side a1 patch 
until it connects to the timeline track you want to use.

- - - [ Go to top ] - - -

Audio Nesting Problems

Emily Rumsey, from Madison, Wisconsin, writes:

I've run into an interesting problem with nesting in FCP HD. My project is relatively long (90 
minutes) and laden with photos as it's a historical piece, so the easiest way for me to stay 
organized is to edit in sequences by theme and then nest them for the final product.

When watching the entire piece strung together, I found minor changes that I wanted to 
make in several sequences. All video changes (titles, dissolves, photos, color correction, 
etc) translated from the original sequence into the nested sequence. However, no audio 
changes translated! I even did a test--lowering the audio clips to 0dB at some parts--and 
none of these changes followed into the nest. I found this very odd and the only way to fix it 
was to re-nest all of the problem sequences by dropping them in again.

FCP doesn't seem to recognize any audio changes made in the original sequence at all. Any 
thoughts?

Larry replies: Hmmm... I don't think this is what you think it is.

I just did a quick test in FCP 5.0.x and audio levels from a nested sequence were properly handled. I think 
this problem is caused by something else -- specifically, a preference setting you may not be aware of.



By default, FCP will only play 8 audio tracks in real-time. Any more than 8 will need to render. What I think 
happened, is that when you nested one sequence into another, the first time, you exceeded the number of 
real-time tracks. Tracks in a nest count the same as if they were not nested. So, FCP created a render file. 
The problem is that the render file did not update when you changed the contents of the nest. 

The easiest way to fix this is to turn the visibility lights off, then back on for the nested sequence. This 
deletes all existing audio render files and forces FCP to re-render. Since audio rendering doesn't take a lot 
of time, this is a fast way to fix the problem.

Part of waht leads me toward this solution was that your audio files were correct when you re-nested the 
sequence. This tells me that render files, not sequence audio, were to blame.

- - - [ Go to top ] - - -

Video Conversion Tip

Martin Weiss, from Hamar, Norway, writes:

A small developer has come up with a cute little programme, Visual Hub (http://www.
techspansion.com/visualhub/ ) which allows for easy conversion between a plethora of video 
formats, including QT, WMA, Flash, and iPod, but also some oddities such as 
PlayStationPortable and Tivo. 

It has come out just a few weeks ago, but the developer churns out bug-fixes and new 
enhancements on a surprising scale. I ordered my copy just as 1.01 came out (and I've 
never bought a 1.0x version before), and it was easy spent money. I use it regularly to make 
quick DVDs. (And I am not connected to the developer, just a glad user.) The probably most 
annoying thing for me (others seem to love it) is the relaxed language of the visual interface, 
which gives it a less professional feel than it deserves.

Larry replies: Thanks for the tip.

- - - [ Go to top ] - - -

Ripping Video from DVDs

http://www.techspansion.com/visualhub/
http://www.techspansion.com/visualhub/


Last month, I wrote about using DVDxDV to convert video from a DVD to DV. Mark Caplin wrote in with an 
second suggestion:

[While DVDxDV (www.dvdxdv.com) is good,] I generally recommend MPEG 
Streamclip by Squared 5 (www.squared5.com/) for this sort of task....

Not only does it allow you to extract and convert Video and Audio from 
a DVD to whatever QT format you require, I often use it to extract M2V 
and AC3 streams directly from the DVD to the reuse in another DVD SP 
project without the re-encode (obviously if no editing is required). 
Not only is it easy to use, but also free, providing you have the QT 
MPEG2 playback component which I believe is still part of the FCS 
package.

Larry replies: I have not personally used Streamclip, but Michael Hanggi, to whom I forwarded Mark's 
comments wrote back saying:

Thank you very much Larry. Streamclip worked very well. 

- - - [ Go to top ] - - -

Archive Follow-up

Philip Fass wrote in with an additional comment on archiving:

I thought you'd find this an interesting tidbit. I just got the monthly HD Studio email with the 
headline: "High performance, low maintenance storage for HD." (www.studiodaily.com/
hdstudio/)

I thought, great, someone's finally doing something about long-term storage. No! It's just a 
massive HD system. 560TB. Imagine if you filled it up and then decided you'd better archive 
everything!

Just symptomatic, I guess, of manufacturers who don't address the question "Then what?"

Larry replies: Yup. I think Dilbert and the current HD-DVD/Blu-Ray wars make abundantly clear what 
happens when engineering and marketing disagree.

- - - [ Go to top ] - - -

Shooting with a Sony Z1 HDV Camera

Gavin Elder writes:

Thanks for your numerous informative articles on the web.

I am currently in post production on a concert video for David Gilmour of Pink Floyd, the one 
problem I have had with the Sony Z1 is when filming strobe lighting, the compression does 
not cope & you are left with muddy fuzzy artifacts.

http://www.dvdxdv.com/
http://www.squared5.com/
http://www.studiodaily.com/hdstudio/
http://www.studiodaily.com/hdstudio/


Apart from that [the camera] is great - so a warning to pop/rock directors & cameramen - 
[lighting effects on] the Z1 can be tricky.

One small question - shooting DVCAM on the Z1 - do you get a much better picture than 
shooting DVCAM on a Sony PD150 ?

Larry replies: My feeling is that if you are just shooting native DV, the PD-150 will look better. However, 
shooting HDV and down-converting to DV will look better than shooting native DV. I'm open to feedback 
from other readers.

- - - [ Go to top ] - - -

Getting a Panasonic AJ-D750 Deck to Work with Final Cut

Gabe Unterman, from Kitay Productions in Maryland, writes:

Since the upgrade to FCP 5 we were not able to digitize footage from our Panasonic AJ-
D750 DVC Pro deck. Every time we would digitize an error would pop up on the FCP saying 
"Tape trouble, VTR problems". We were able to control the deck and use the "edit to tape" 
function in FCP with this deck so it was very frustrating. We control the deck with the RS 422 
connection through an AJA Io. I called Apple and they told me that the AJ-D750 is not 
compatible with FCP 4.5 or 5 (the deck worked great in 4.5). I called the company that 
handled the FCP upgrade Chesapeake Systems, Baltimore, Maryland. They found a file that 
disables something in the Io that allows the deck to work with the FCP. Excuse the lack of 
technical terminology. I don't know exactly how it works but it does. The file does not affect 
anything else in the IO (so far that I can tell). The file is attached with instructions. This might 
work on other Panasonic decks that are not compatible with FCP. Good Luck! 

Larry replies: Thanks for writing, Gabe. I urge caution when installing patching software - so read the 
instructions first. 

●     Click here for the instructions: 
●     Click here for the utility (in ZIP format)

As Gabe is using an AJA IO capture card, this software should only be installed by someone with the same 
Panasonic deck and AJA capture card setup on their system.

Update. Richard Daly sent in the following:

Your reader's letter took me back to over 100 tests I did when I had similar deck-control 
problems, in my case with a Panasonic 450. I finally found that the answer to my problem 
was not to use, in this case, the Blackmagic DeckLink capture presets, but to modify an FCP 
preset (in my case, I modified the DV-NTSC capture preset). I had both "tape trouble" 
messages, and also problems with batch capture where the capture stopped before it should.

The solution was on the DMN Forum website, posted the morning I first visited it(!), as 
follows:

"We have encountered this same problem. Solution was to select one of the 

http://www.larryjordan.biz/goodies/AJ-D750 FCP5 Fix.pdf
http://www.larryjordan.biz/goodies/DisableAltETTPolling.txt.zip


FCP own presets and modify it to use Decklink card for video and audio. After 
that the problem went away...."

I also found that using a Keyspan USB to serial converter box for machine control works well 
for me; I had more problems using the DeckLink VTR control cable.

Also, carefully test both gen-locking the deck and (in this case) the DeckLink card to the 
same signal (first method), or synching the deck to the incoming video signal from the 
DeckLink (second method). (The DeckLink generates an optional black signal for the second 
method. I don't know how the AJA Io accomplishes synching.)

The above solutions avoid patches, which is good. I realize my problems and solutions were 
for a Panasonic 450 and a DeckLink card, not an AJA Io, but the approaches above might 
help. I say this partly because I used to use Grass Valley's tape-to-tape edit controller with 
my 450, and their 750 protocol works perfectly with it, so I think solutions for the 450 would 
also work fine with the 750.

I don't think it's correct to say the the AJD-750 is incompatible with FCP. I finally found a way!

- - - [ Go to top ] - - -

De-interlacing

Roy Close writes:

Last month, the article on de-interlacing caught my attention, as this has always been a bug-
bear to me as I use a lot of still graphics with horizontal lines (buildings, overhead wires, etc) 
and never yet found a truly satisfactory solution. So I eagerly went over to http://www.100fps.
com, and spent the next hour or so trying to stop my head spinning! 

Whoever wrote that article REALLY knew what they were talking about. Everything sounded 
so good, and I was beginning to get excited, until — all the time, the writer was a Wind**z 
user, and the solutions suggested just about all involved Wind**z software such as 
Virtualdub and Avisynth.

Does anyone know of similar solutions for our Mac platform — meaning FCP, of course?

Larry replies: Not to panic. Yep, I agree, the article was pretty intense and the bottom portion didn't really 
apply to FCP editors. However, Roy, there is a perfectly fine de-interlace filter built into Final Cut. Select 
the freeze-frame, or other clip that you want to de-interlace, and apply Effects > Video filters > Video > 
De-interlace. 

http://www.100fps.com/
http://www.100fps.com/


The pop-up menu has five choices. In general, I recommend the default setting (Upper/Odd). Keep in mind 
that you will NEVER see interlace flicker on your computer monitor -- it only shows up on TV sets and 
video monitors, which is why it is so important to look at your work on a video monitor, and not just a 
computer monitor.

If you don't like the way the filter looks, try one of the other choices until you find a version you like.

- - - [ Go to top ] - - -

Choosing the Right Font

Sandy Schwartz writes:

I have a questions about fonts. I am working on a project with a style guide. I can't seem to 
load all of the fonts into FCP that they prescribe. Is there a reason for this and is there a font 
type that will always work?

Larry replies: There are a variety of font formats out there: PostScript Type 1, PostScript Type 3, 
OpenType, TrueType, bitmaps and others. 

Final Cut only supports TrueType fonts.

- - - [ Go to top ] - - -

Converting VHS into Something Useful

King Dexter, a long-time reader, writes:

I have a DV project that will require that I import and incorporate some clips from several old 
VHS tapes into Final Cut. Can you suggest a basic, straight forward and reasonably priced 
configuration that would allow me to digitize some of these old analog clips and bring them 
into Final Cut? I suspect we're talking about some kind of ADC, capture card and/or 
hardware set-up. Since this might never become a routine part of my editing workflow (as in 
I may never have to do it again) I'd like to keep it as basic and economical as possible. Any 
suggestions you may have would be greatly appreciated, as usual.

Larry replies: Here's the process: copy the VHS tapes to DV using a Time-Base Corrector. That way, you 
get a modern tape format which is easy to copy, the time-base corrector cleans up the images and 



stabilizes the picture, and you don't need to spend money on capture cards you don't need.

A good, and reasonably inexpensive time-base corrector is the Datavideo TBC-1000. It's about $350 and 
you can learn more about it here: www.datavideo.us/products/tbc_1000_main_page.htm

Take the composite video out of the VHS deck, into the TBC. Then S-video out of the TBC into the DV 
deck. Then, capture the newly recorded material using FireWire into Final Cut. 

- - - [ Go to top ] - - -

Dealing with a Bad Drive

Tom Dukich writes:

I just got a new Lacie 250 GB external hard drive to add to my three others for a feature 
length project I'm working on. I set up two virgin Lacie 250s as primary and secondary 
scratch disk like you recommend. So far so good. About 75 GB of DV on the secondary new 
drive, 130 on the primary. But.....

When I put everything to sleep for the night the new Lacie secondary won't go to bed. It 
spins down then wakes up again in 30 seconds despite the fact that all the other three drives 
and the computer remain sleeping until awakened. I'm working with Lacie to get a fix but it's 
looking like the drive is bad and needs to be replaced.

So, what's going to happen when I move the contents of the secondary scratch to a new 
drive? I have not yet used any of the clips in the 75 GB's in any FCP sequences, they're all 
still just in the browser. The sequence I'm actively working on has all its clips (130 GB) from 
the primary scratch disk which goes to sleep just fine.

Any help would be greatly appreciated. Thanks.

Larry replies: This is not a big problem. When you get your new drive, copy the files from Drive 1 to Drive 
2. When you open your FCP project it will indicate media is "off-line". Go to File > Reconnect media and 
find the missing files.

It should take about 5 minutes to reconnect. After that, FCP will find media on the new drive without any 
need for prompting.

Update: Ben Balser had an even better suggestion, after reading this:

Larry, there's an easier way. I've replaced two drives this past year. Upgrading from 250GB 
drives to 1TB drives, both. Drag-and-drop copy contents of each old drive to each new drive. 
I opened my FCP project (a very large documentary I'm working on) and of course 
everything needed reconnecting. It was a LOT of material and I was not in the mood to re-
connect all that media. Since I sold off the smaller drives to a friend they were no longer a 
part of my system. So I renamed the new ones with the same names as the old ones. Re-
launched FCP, no re-connecting needed. I never had to do any media reconnection after 
renaming the drives. Last week I had a consulting client who's media drive was full. He 
wanted a larger drive rather than a second drive. So we did the same swap-out process as I 
had done with my own drives, no reconnecting needed. Just thought I'm mention it.

http://www.datavideo.us/products/tbc_1000_main_page.htm


Larry replies: Ben, this is a great suggestion. Thanks for sharing it.

- - - [ Go to top ] - - -

Running Avid Codecs on an Intel Mac

(Now, a year ago, I would have been pretty surprised to see the words "Avid" and "Intel" in this newsletter. 
But, well, we can be open-minded...) 

For those of you that need to access Avid files on your new Intel/Mac, you'll have discovered that they 
don't work. Avid hasn't updated their codecs to support the Intel chip yet.

However, Björn Adamski contributed the following workaround:

Enclosed you find a trick how to run PPC based QuickTime codecs
on Intel Macs, e.g. the Avid codecs.

●     Install the files as usual in /Library/QuickTime/
●     Select the QuickTime Player and open up the info window (Command + I).
●     Activate the checkbox Open using Rosetta.

Now the codecs will run under Rosetta emulation on your Intel Mac.

Larry adds: It is important to note that Rosetta emulation will NOT be fast enough to play these files in real-
time. But you can use it to convert from an Avid codec into something Final Cut can read natively.

So, don't use this to edit -- use it for conversion.

- - - [ Go to top ] - - -

Working with Slugs in PAL

This came from a recent email exchange. I changed names to protect identities. 

End User:

I just noticed something interesting. When switched to PAL project settings, slug still 
generates as NTSC footage. 'Color' (from generators again) does appear as PAL footage. 
This became apparent when one of my clients wanted to insert exactly 12 frames of black at 
the front. Generated slug in Viewer, set duration to 12 frames and inserted into the Timeline, 
whereupon the slug duration only lasted 10 frames.

FCP Expert: 

Yeah it's a bit of a weird one. Works fine for whole seconds but not when you enter frames. 
Seems to be that Slug & Bars and Tone aren't really true generators - they appear as a 
graphic icon in the Effects Browser. Probably connected to the fact that they generate an 
audio track which true generators can't do.



All the other generators work fine and use the current sequence setting for their frame rate 
and frame size.

Larry adds: Apple just last week announced upgrades to several of their PAL video settings in the 5.1.2 
upgrade. We shall have to see if that fixed this particular problem.

Things I'd Like to Know

Doug Lyons, from Seattle, asks four questions that I don't know the answers to. If you can help, please let 
me know and I'll publish them next month. Doug writes:

(I'm an editor with 30 years experience, and I've been on FCP since version 1.0.) After a 
good month of non stop fast paced editing with FCP, Motion, and LiveType I have a few 
nagging questions to which I have not found any answers. I think many of your newsletter 
readers would like to know what you can find out about these issues.

1) Livetype has lots of nice glow effects which I use all the time but whenever I import them 
into Final Cut Pro the alpha channel is understood to be straight - which I would think is 
proper - however all of the glows have dark edges to them which means they have been 
premultiplied with black. So I have to go and manually change these settings in the item 
properties. I feel this is wrong. With all the touting Apple does about the "round trip" features 
of FCP and Livetype, I would have thought that either livetype would export alpha channels 
as truly straight or that FCP would understand that anything coming from Livetype would 
have a channel premultiplied with black. Is there anyway for a user to remedy this?

2) At the end of almost every session I export a small quicktime movie for review by my 
client. I use the "export with Quicktime conversion" and I use the "Broadband-medium" 
preset. But the export dialogue always first offers the "Default settings". In my case, 
exporting a DV clip gives me a 720x480 with H.264 compression. How can I set the default 
to be "Broadband - Medium"?

3) Why do elements sent to Motion from a standard DV FCP sequence show up with a pixel 
aspect ration of 0.89 instead of .9? My Motion preset is standard DV.

4) Finally, TIFFs I create in photoshop that have transparency, work fine in FCP. And when I 
bring these directly into Motion, they work fine e.g. the alpha channel is properly interpreted. 
However, if I use these tiffs in FCP and then decide to send the layered project over to 
Motion, the alpha channels of the tiffs are ignored. This is quite irksome when I have a 
segment with several tiffs moving through and now I have to go and tell Motion how to 
interpret them. Any suggestions as to how to deal with this? I've experimented with setting 
up the project as using an animation codec with alpha output and event then it doesn't work.

Wrap-Up 

And on that note, we come to the end of another issue. Please take a few minutes and:



●     Register for one of my seminars
●     Subscribe to Edit Well
●     Visit our store and buy a DVD or two. 

Your support of our seminars and products keeps our website, and this newsletter, free. 

I'm grateful for all your comments and questions. I love hearing from you because when you share your 
ideas and suggestions, we all learn.

Thanks and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 450 KB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at www.
larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, rented, or 
bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However, due to the 
variety of possible system and software configurations, the author assumes no liability in case things go 
wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not been 
reviewed or sanctioned by Apple or any other third party. All trademarks are the property of their respective 
owners and are mentioned here for editorial purposes only.

Text copyright 2006 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without specific written permission from the author. 

Links to my website home page or articles are welcome and don't require prior permission. 

 

http://www.larryjordan.biz/sem/2006_fall.html
http://www.peachpit.com/editwell
http://www.larryjordan.biz/store/index.html
http://www.larryjordan.biz/nxltrs/ljnxltr29.pdf
http://www.larryjordan.biz/nxlttrs.html
http://www.larryjordan.biz/nxlttrs.html


    
    
    
    
    

Home | About | Training | Articles | Goodies | Products | Email Support | Contact

© 2006, Larry Jordan & Associates, Inc. All rights reserved. info@larryjordan.biz

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/about/index.html
http://www.larryjordan.biz/training/index.html
http://www.larryjordan.biz/articles/index.html
http://www.larryjordan.biz/goodies/index.html
http://www.larryjordan.biz/store/index.html
https://host119.ipowerweb.com/%7Elarryjor/supportemail.html
http://www.larryjordan.biz/contact/index.html
mailto:info@larryjordan.biz

	larryjordan.biz
	Larry's Monthly Newsletter - #29 - Sept. 2006


	BJIHONPOFBBEEHACMBDGEKIFIJGJNKPE: 
	form1: 
	x: 
	f1: Enter your email
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 

	form2: 
	x: 
	f1: 
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 




